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Calibration

Signal Path Compensaon (5P C) corrects for DG inascuracies eaused by
terrperatire varigions ar by long-term crft. Allow the osciloscope 1 viarm up 20
minies before running SPC. Run SPC ihenever e ambienttemperature of the
osciloscope has chianged by more than 5°C.

SPC il be adversely aflected by Inputsignals with AC components. Disconnect arty
probes or input sighals before running SPC. SPC may take over fen minutes to run

[ amvays show SPC status
Disnlay awarnhing when S

2% MEfJ 2= (Temp) 2 HZE
=/ WA (Calibrate) S 2 5104
™2 AlEgHct 1™ 2108
olM 152 M= Z&lu
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EASIAHLE SPC7F = 2 of A Al
X gt Z20E EAlSHHH
A SHES ZE UL
SPC € 2 ofo| Z 0| w7t ol H
NS 22 2 g sd ot

DPO7000 Al2|=, DPO/DSA70000/B

2617-072

Calibration

Signal Path Compensation (5P G) eorrects for DG inaceuraties caused by
termperature wariztons or by long-term drit. Alow the osciloscope 1o wart up 20
tintes before running SPC. Run SPC whenever the ambiert temperature of the
oscilloscope has changed by more than 57C

SPC will be aversely afectect by input signals with AC companents. Disconnect any
probes of input signals before running SPC. SPC may take Over ten minuiss 1 run.

[ Always show SPC status

Display a warning when S

1733-056

2.0ns/div  50.0GS/s 20.0ps/pt

Sample

449 acqgs RL:1.0k

Aute September 11, 2008

2597-020

MS070000 Al2| = W2 A|&F AL Ao A



ur
ofl”

Qo O 00fggo=0)
ol: wo

cogmmoo

0

0o

000 ()|
00000 |[HBe=0
O O o|owo=<0

i
©

T
Tl
S
N
<
o]
Pl
ar
ol
1
Il T
T
H| jol

—

E ==l

— 1

=13

g ot

A
ne

|5k &yl
7| LA

=

<

nEEER)

4GHz o|

2597-014

Ll
o

f

E
=)
Q

L

2597-008

Vertical

1733-014

25

_I

2D

AtE

PN
Al

, DPO/DSA70000/B ¥ MSO70000 A2 = tiE2 Al

=

DPO7000 Al2|



Jor
dn

e Y s

=
—=
x|, AU W 2EMS xH

Autoset Selu

= A = p
IRl iR | O & @ @
Eéﬂ ?_l'O‘” 7('_-|§I_|-6EI- 4\— 9}%'—*' |' @ Push Fine Horizontal

Position

Multiview
Zoom

@ Push‘r ‘Se\ect
AN
= Scale

O

0 6383
0
8 axg &

2597-009

 ME g 2 AL E5t0f = HorErt
9% W A LS =H o), @
28 Xl A E2|H U AR |
Ea|A MEBo M5E ZHEY

C}. ‘éﬁ"\ @

More
Samples

{ Scale D

1733-016

ZI| MEf |2 HAHO 2 =
A El=2lsidH 7| 2gt A™ @
(DEFAULT SETUP)E &2

Default
Autoset Selup
Run/ Single
Stop ing|
@ Push -G08 [ Horizontal

Position

Muttiview
Zoom

G

1733017

DPO7000 Al2|=, DPO/DSA70000/B % MSO70000 Al 2| = - AlZF AFE A H A



ur
o o
<4 B S W. 35 R
== (> 2 W4T oM mT
n| H A o M ® T
ENC) o - =<0
i o it m o
mju M K =R 5 o 0%
s E T T I T
G £ H o K@ R puw
W z = RS F gl
= p = NK o 4 K
N o =i J - - — =
R = AN WI_ T &R
uf <> 2 o3 o O ®
- - 2 g Uy BEOZ aw
T 2| |8 < 3 - f— | -
70, 18] (B3> -(3) = T 0 Wl g xR
= HE3 = 761 ol ey - b
S _H_ < Lo T = I3 Bl
o — T = kO I koo o
e @ L w I -~ ] Ho =
ol l__/I o2 ol =2 o I_.A_I
= Eel 4 = L ar
E=) =0 = K {0 N =
=4 _._.__ oo O_ —_ |_.1|_ U K
KO =l W o°F TR OB S
w F] = A_l 1o A=
H i =) B o K KM o op ol &
Ol g 50 ; w F me = g
x|I el _ : o o o o Sar
ﬁ_/ o @ MO @ E3 mm o X zo K0 X
. e 4 RN @ S
7o N 5 W0
70 ™ 2 Wy =_ T 4
" 8 RT g2 = T
o O RS BRI Y S =i wy w Mn
o] .J_M.o Tor . ol A arolT T oF o3 o< __Hou < = __Mo=_
< TRk BT RE M gy M M= Mﬁm L
- LHO slowl <M 0 1 750 Ol _ =< w <R
_._.__.l_A_l - = H = _ - l:r.T_ Ho <+ < <0 0 B
oI” ¢p  UIE _u_w o 2 gyl m_ﬂ oz Hol o zmuo
muI D& BE WS O KRR T o R
IR ST R U s RO =70 ol o oFK T — g
lo [0 K s url
=31 =% 7 NOR . R
—_ =< bl el =K KE Ly e ~ — — J— —_ o-
< Om<kwp Wwe <{ Mg I KB R T R OHl 0 Mg gz
Roguiel DTN Ko T Em o @ w Sa sa mz
R0 oz MM UK RETIR W BR Tw OWE g
B2 =) N o AT o8 0F W R OB w<l E<l <=
_|_._ ) _._._o _._n_ - : @ = u u ] [ ] u
0
—
K

27

to| XtEo 2 olp|X|

o

=

A

q

o

4 0

A
=

M A 32 Hof
Xt ALZ

M
=

tof At=

, DPO/DSA70000/B ¥ MSO70000 A2 = 2 Al

=

DPO7000 Al2|



ur
ol

wof
T
i
i
n
all
%0
%0
KIr

mAlE Z28 Y

%0
E
pijl

H
20
il

i Ny

Zt 2 ol
CIXI™ do]

5t

Chalag
=
[

b=
o
x

5
C|X|E}O| X 7}

| & x| d

#
ol
=<

A
o

<" =0
11230 oy
o] T
domu

STl T
M H K1 T qo
uIr = M 361 KO
WoUu TR

o
Hi
il

|

<l

ol
IH H
4dr
i
=0

O 2| 2 E

or N H

T -0
ourD 1 3
=T
T o B0
200 oS H
sy oo 7o
TR
s <
70 W U oy ©
Hiu F Wl 0 5l
305 ol W zr
M
X Rl ol
MWW o< I

_I

2D

DPO7000 Al2|=, DPO/DSA70000/B & MSO70000 Al 2| = & AlZF AHE

28



ur
ofl”

o
Hi
3l

N

M___

HJ
~

—_

ST __ou oo 11
T & P4 5y m._
R0 75 T 710 T F o opul 2

111 00 TU iy il O 770 F J

i
TXK H_uL._ LT A_
o ™ o<

S iy - o N
0 1| E_EI =) xl_.
bl 1 W] O_Ea >

30 ol _ 10 wr
MMPWn%%%F
<ol = ol o = o_E
< E > H :E ujr
o 41 o = ol T 0
N 0 o T O 4
HioWoTTHI T 7o &K

o0
i

==

<
—r

~

ulo
lHo

mn i
e 2
| < <
5l ur ur
C] I
U = =
_._.._ m._ m._
T ®e U+
—
—
—
—

6T TS MU
A KT __ou NE Ly )
_xo < _xﬁ H 3
o__= o g0 < 4r Gl
=0 < Mr o < L| o0
b gy H oo S gy <
nn_”_ _u_l_ __O mo _x_._| .A_u _HL
=] Hin = Y
:
N ﬁo S o
ez =
:_o iy 5 s a. ___
1o D00 o oy < ___H
T ° o Erons o
KOS Z0TT TIa0 N RO

Aol 2

ulr

nelil £5 Afo| 2

”. M eHmy =l

.Q:_Jm._

o_e H Oy
B0 1o 1 iy 751
R 30
ol ol il ~N = __nM
R o1 < 0jp
BT 2yp<
3 D10 76l U =
Ws s
ERG m_ o]
ROUrs M@ <d

29

_I

ZED

AtE

PN
Al

, DPO/DSA70000/B ¥ MSO70000 A2 = tiE2 Al

=

DPO7000 Al2|



ur
ol

ul
™

100
—r

El

& 510

074 H =5 A
L ot

| &0
Ul
| |
Y

|

ok

®
!y
Ul
™ oI
T <+
@ i
EREl
Z Ho.._
A O
ul ™
i o

= A

A
T

4 x|910] HA U2

AL
(=

K
oF
HO

<+

—_

RH 3T
ol mju OF Jjs K WI<k
Roouw®ols
o~ oF <k od <+ M
< “_u”_n_.._._mOHm.._ln_UI
NH_

[}
)
o1 KH

IL|C

(o]
=]

—

s

E= 2t
ol AXY A2 H Eg|

3l 2 =of

2| H
EbE L Cf.

E]

o

E]

o
M %8 7| Zokx| 2l A

7+ 50%0] ™
XAyt

=3
S:
S:

—r

~|

5 H
~N |
Al ™
ke
Jper
o ™
Ul s
W30
= )
ojn o
o U
_wr

TRT
ul o3 77
LR Sy
N i 0l
80 350 <
EREES
11 o
o~ U
K0 ol

Fod &
ALH|

INR=AS]
o &2

—

=3
=

5
gk

2k
A2
AHE

_I

2D

, DPO/DSA70000/B % MSO70000 Al2| = 2 AlZF AL

=

DPO7000 Al2|

30



ur
ofl”

1733-209

g
&
b

1733211

1733210

1733212

SR OO W R A PV P = P

<O | ol o) i 70 <F

.u_u._ur__u N._WI_H.“A"_”:._E Hlur__u_._mo T Aok ﬂM._ﬂumL. of R
BT &%4.7&_“ S H S ®Kofu ﬂﬁﬁMi%o ,awﬁ_tn@
T U = uur | zwzm® 1z
TR Slamgpkt o| N8 urulE | s AU < = ur ur
oK — ] <= —— oo o . |V < W
— ﬂ_.o_nl_l__u M.W_.__._A .__._o_._q ur= = __o,_.o._Ju.Béq Kto 1 o ﬂ__|_.__ :_m|m._r__3
E = ~ o op o8 HH g __%o_ex, 0l _i._u;Lou ur ® W3 EﬂWM%
O_L _._I__.E_mu _._Tﬂ._._hmﬂm_ro“_o ._hﬂ_;_u_._._ n___.ﬁ..:__/_'m“__m N ﬂwu_;_n._ A_@HOEﬁ
] o e o T on%0 pHL uFN oy |oHS#HR
HO & e o EE;H.&W __ﬂ A ﬂo____ m__LoWw_m_.ArE < T H®
v o ==r ulor o + & Mg T RO~
[ JH ) T M3 |HKC pu'Hyy = [T 4R
=5 =+ |_|r - i — g n —_ —_ —
R s s T e T S TR T T o e =
U| oy RINTU =g §TEH [m s M| H ok | TF 555 gl
H W mur ® Hgor [ FWER |SE T E | Ul THmo |83 gD s
JAF 0 HXToMa THITN |AFTTH BWMHIIOK | FUrdok HN
jr
ol

31

_I

A

q

o

u}

A
=

AtE A

PN
Al

MSO70000 AlZ|= titE Al

, DPO/DSA70000/B &

=

DPO7000 Al2|



Jo
An

ok

32

[

Job

—_

-

S EZEE #HASHH O
44 /& = (Horiz/Acq) >
E (Acquisition Mode) &
Ct.

a

I=Epcz
Wfms)
HE =252
4t WimDB
M Z (Samples)
H =52
et

r2
nz
02y

o n

lu e

L g
> [H
ET

T
i

=
Fal
u}

M 10 w4y 1o 2,
I
I

iy o M

i 2 px o
M ol rir 02 kI

—_

W [m [0 12 u N e

D= HO ook |m 2 o
1o

M 0 gy Ay

Rl

DPO7000 Al2|=, DPO/DSA70000/B & MSO70000 Al 2| = & AlZF AHE

Trig

Dizplay

Hotizortalidcguiztion Setup. ..

Zoom Controls...

Autozet

Fast Acouisitions

Run/Sto

p...

Delay Mods On

¥|| Roll Mode Auto

Sampling Modes

Position/Scale. .

Horizontal Modes@

Resolution. ..

Acouisition Moce

Fazt Frame Setup...

Zoom 5

etup..

Zoom Graticule Size

@

Sample Acruisition Node
Pk Detect Sample Ph Detect Hi Rez
e o @ @
o BB @
Average

1733099
Wfim DB
Mode..

®

Acquisition

Sample

Pk Detect

HiRes

Envelope WAmDB

5N

Average Samples

100000

M

A
=

1733-060

[g

A



ur
ol
0 @
<+ =
-t ﬁ
ol
2 ol
13 =T
z = .
W Y
o ~N
@ i %0
w1
ape u
. [ < o
ks by A
o @l i é
5 o =]
31 [ F o) : 2
- @ = Z
ar : 2
w © g o 7
o [ -
Rl om m n -
— Sa - ]
2 <1 30 3 n g Sl |
o - ¢ o H4 5| &8 c
i o £ a3 |8
Ul o0 Oe o £
= < . :
™ i 0
Bl K - T .
] Mmoo oo o A0 ur Lo ® moulBIUIrm 4
; S BT w b 5 WEFD  WAammol wE
ﬂﬂ ] m&u E__mur__u o ~ RO r Mmaﬁuuzmn_ewm n_eﬁoq
< = 3% X7 wQ U FmWo T EyIRWR =g,
i b T TEl g5 o FUr S T o0k Hag
Sk Ron OR =l = =R ut
F _ ®m Rm pX @l 0 AT E = < MR o CATRE
ol K = Rur QR0 4 Fr TP AotspulmY N
b z o Zo oW U RS Y HE® 2%
i =0 T BE S gy a1 RS PSR HAE R oy
=< K ol Mg ur _.___.E_L_ ﬁﬂ = Bl pU A B Ko < ITmE T 4 [0 —~ =
11 — vt s __ =] o I_J. = ~ - _./Ir
! ok m W R LR Tl TF W533C Ty EHD gy oumY
oI N = = _A/.__A_..____ . 10 =l Ul AnnuA.__M_A_.o _.__Me k{0 ‘o ol Roq o
I . o - S~ == —n
2 KM m B &7 L& Ul sw HIF0U Moy i T < 0 g00 o
= — yr RI AT U o Tu m5Eo W50l 5 IS Huw H
= < ¥ - & o o IRz | R 4r NURO N LH Kt 204 31
ujr H0
o <+

33

.l

A

q

O
o

4

A
=

DPO7000 Al2|=, DPO/DSA70000/B % MSO70000 A|2| = tiE A|Zf ALE



ok
An

34

e i sel el 2|

ecord Length Limit)
1%|4ﬂHEEM
MAyeruct 712 =[O
I.O

of|

JUmN |n
2y
o
e
m_

-

ot o
pmmﬂ

M2 oknjo b
mo = T.

i T 2y (1 g

oro >

2l ctE L |:}

|3 oL
<
e
1o o
% ||'|
0 e

i
0z
UM
on
I
kN
2

bal
—
]
=z

I

I 02
Moz
oy

rir oY |
o

-

g

gm
=

t
na I
0

N
oflr
0

o DEES
o
T
n
T

B2
DX

ot o
= H K

[N

O O X mo |m N Jy T ol o
[
2
it
o 10

ot s OMT T
4> H o= &
20 o MK
r£re

o> |n

DPO7000 Al2| =, DPO/DSA70000/B % MSO70000 Al2| = titE A|ZF AL

| II-H' El:il l:ll E."__T;_

Horizontal




ok
An

TS REMEMESE Y AZ THorizontal

S Yolg M¥E % ARUCH +H

AAYe ME S5 8 d=s 2ol

of el Al AbEl = E4 s 4ol o
OlAT = 35 ZE0AM X[ d =X & v A

=
— o
2EoM 3 =ZE HolE HEE 5

A& .
MI7IX 2E= 25 J2lo| M A H
ME &S 24 2 elzE 2ol
ol At ztgstct Ogel =¥
2iel2 z[of AAZEMEZ Sl 2 2=
Ch. Zt At A LS ZSIHAI7|H 2ol
AERIZFMHESHE 2l 2= Zolut
H 2= Zo| Mol =etst A2 M
28 &7l Eo{E0{of stct= A S .
EoggLch s 2=z 8= A<
E Zo|E A2yt
Az A ME ST 2= S
shuct cf Y MEZ &5 2E0
MeEOYE S dEHE ASE
fe S22 MEY S0 LY sH
FX|E Yt
=
B CIXE MEY £ Y lMaTEE S5 H0|7] I 2o, MENStolEd 20 MEE S 2ol w2t A
ofE 4t
2 = k=2
N5 2S5 AE
I 35 2= E A25H ot 25 7t2| o= AlZto] E0{E7| I 2o 22|%x E=HME HA S
Of YAMOl O|HEE ZaH g FA|E = ASGHCH IS S 2E= L5t UMES HHS= 4L
2 Oty sAS FAIE 5 A& o).
CIS EXIE AFE3IAAIR

DPO7000 Al2|=, DPO/DSA70000/B ¥ MSO70000 Al2| = ti-& A[Zf ALZ A HAM 35



Jor
dn

36

. 1% 3 E(FastAcq) 2 +ELIct. @
Intensity
Clear ) ( FastAcy ) @
Trigge r B

1733-216

| &0l
fu . (141 H|

r
m
2

o |M
N

-

1733218

we g
g‘ Z|\_ HA
=4 /& £ (Horiz/Aca) > =4 /&

A S|

o
1% & 5 (Fast Acq) 2 M H °F EP = X
Jc*(Capturlng rare events) =

B FastAcqg ZEWAM = CXE ME HAE AS
Eo| &S % M35t
p) > ES(A Cqu|S|t|on)>
X ZHCapturing Details) EE

JII'I
Jl o
I 0

B ME AtSEEE EZ O H
=3

(HorlzontaI/ACQU|S|t|on Setu

(Optimize For) M5 A}gt
MEd gt o}

Ir
Iy
Ao
o
=3
Im

o

DPO7000 Al2|=, DPO/DSA70000/B & MSO70000 Al2| = titE A|ZF A

2 Mof

=

o

A



SEA ok =" =2
DSP SHAIE DS Z ALS

hulofl sHAMEl A E 7] So0| Qo8 DSP(CIXIE A5 Hal) stabel of of
Bt Mot EH L2 Y ES &SI lAMES M HEEY
Ct. 2babzEl Y X2 M3t A DAof cisl L xSt SEHS M35t
e odgd s AES Lot
1. At& 4™ (AUTOSET) 2 =21 &

B 43 E2)) HEES A

Moz} sl HEES 52

Eggzblt Autoset

Selup
O ] Jone ]

@ Push g} Horizontal

Pasition

Multiview
Zoom

1733-020

P

2. =7 (Vertical) > &= of o
£  ..(Bandwidth Enhanced...) S
M I:'—||'I Igzll- I’l = Yertical Setup...

0

Zoom Controls....
Dizplay Onioff..
Position/Scale. ..
Label...

Offset...
Termination...
Coupling...

Bandwicth Limit...

Bandwidth Enhanced... @

Db ~al 1733-227

DPO7000 Al2|=, DPO/DSA70000/B % MSO70000 Al2|= & AlZF At A

%]

2 b i
s 1 M0

=5

e

A

o
An

-
ol
—_
(@]
I
>.
—

H >
pRLY

for

|1|9,£ 0
> 0>
30 >
o>y

a

o TH 00
A T njo

=
Lo
Kl
o

Rl
Off

37



ok
An

38

3. Ol X[ EE (DSP) Al (Digital
Filters (DSP) Enabled)2 £ & 5}
of &M= A ZS M T},
DSPE &M3ststei™ MEZ
£ SHl=2H M H™s5lot

Mt O

| &=
[ ]

0
C
i)

N
@)
(@]

ME!
m
mn
o
0x
b
o
pxAr o

o0l T
[
M
W
oy
I
kn
oy
B

n 1=
DS o
° >

a1
_I_IO_L>|

org

O r2
il

JEQ oz

%

s
w
Q
3
o
)
my)
=4
o
mu
[k

H’
KRSl
o
o

on

0% 1%
o 0z

%)
U
kI "
My H
o i "
g
i
e
i)
0

izl o

1x Kl Ho

k1 g 1> 110
I o 0F!

)
_ol
Hn
Jhu

=

02 O |nme 4y
o I %

ol
[miLl

O
wn
Y
A
12
I
o
rx
12
E"-
L

[6)]
o
12
I
r @
Q
>
Q
z
g
£
Jo
I
]
>
o

ott= 12k sl & (Analog Only) 2
MEdSIH StEQ O (HW) O H =

o MEHE L|C},

6. MEM stE2 2 E & doll HE35}
gHH ZE Lo HE(Apply To
All Channels)S ME4 sHL| C}.
CtE2 24 o2 Qs Zd|of A
DEMES sdstA A™HE =
N dF 2 AME2 7tss & 7t
I Y E gtez Y E
=
ShAMEl O e Zo0| 7{X| ™ =Z] gt
S0l thd = FA| 7|7} LiERL
=

= =

" O HE|S0teA SEZ W ECR 22 MUY A E U | BAE (4 E MY S MY
C

T A= M w7t HHEFE

Vertical Setup

Display

Label

1733-239

[=13
=

| @B 100mv/div MO By:500M

1733229

DPO7000 Al2|=, DPO/DSA70000/B % MSO70000 Al 2| = & AlZF AL A H A



o
An

Fed X 2| 2ol E'Réﬁ'l Lt A._§7P Hel = Z'SJ"—PéPE A E= 178 DSP ALF HE|E ALE
0 e F

Vertical) > tH &4 = A SH(Bandwidth Limit)& MBS CIS i H ZS M50 HH| P =S
I

Hetet 5 AgH ot

EREc MFLUF USE QS 2ER XAE Y AH B RE CI2E0|E MSRHCH & 220
Me A oy el 227152 M7hx| 7|cte|X| 205 & Sstole ZAEE 8 = As4 .
1. =9 /& 5 (Horiz/Acq) > T4 /& H.;.r-i

£ M3 ...(Horizontal/Acquisition

Setup. . )% M g|4 EL L |:_|._ Horizantalfdcouisition Setup... @

Zoom Controls...
Autozet

Undlo Last Autoset

1733-064

2. MEHEO UX| 2 2B EE

(Acquisition) B = £ = st C}. Roll Hoda

A}=(Auto)S 28501 E REE @

At
FALE EoCE ARsE M el
%’ _LLIE_ 4 7: EIEE Hl Res i_!% EE 1733-065
E AP*oH 0# s ct.
3. EZEOM EES YX| 5tz ™ @

=t Zafof UK e T

= — o
A&l /A X (RUN/STOP)E &8 woset S Fasthcq
=oc=mxc) O O GO @l =) Gm)

Intensity

@ Push-Ene Horizontal [ Trigger )
m Y Mol e Z o= g s
Hete|mErtesSxH E L
S ESo| A5 HAE
ct
e g
W UWERIT BEEEWMDBES 2SR MEstd £ 27 AXN O

B ERE=5YH AHYS 50ms/div ECHiEA MY e 4 o &M 3HE ot

DPO7000 Al2|=, DPO/DSA70000/B % MSO70000 Al 2| = - AlZF AFE A H A 39



Iz & gtoa{d o X2 M (Digital Setup) Ml woll M CIXEH AHE S dFetct CIXE HE2
MSO70000 Al2| = ZH|of Mot ALE S = A G L T

1. 228 22 5 Zd|of| A Z &Y =
EI— cooaIDoo
O 0|9 o
e ===
2. ZREHE YH AT A0 AZA ‘@'So@o
st o 30Iss
[a5) O (&) (&)
ZFo|, Hu| 2AZ 9K 5ta{ ™ ZH| o o o o
of AZ et stat MMI| &HX| &= O 000
s 225t 2 H4YEol of st a
o) oled Mot HAS Eaadc) i CIEIEE
_J
J

3. CIX| & (Digital) M woll M CI X &

Mot HAE MYt
(40H|O|X| 2| L/ XS HE A& FH=E)
2 (41H 0l X| o] H/ A M EZE)

Digital

Diital Setup... 0—.

HorizfAcg

Bus Setup...

2617-080

CIXE 2 43

40

MSO70000 Al2| = EH|o M= CIX|Z & d threshold, 37|, 1% H &flo|5S MAE & 5+ A&H

1. C|X| & (Digital) > C| X[ & M X " .
(Digital Setup) & 41 gt ct. Digital | Horizicy
Digital Setup... .—.
Bus Setup...

2617-082

i rim
=

AL 2 Z:A
Mg o

2B17-007

DPO7000 Al2|=, DPO/DSA70000/B % MSO70000 Al 2| = - AlZF AFE A H A



4. Threshold EE = 2| %] (Position) &

=™t E= M9 threshold
o gt2 st M EZ(Apply) S
215101 1670 M 2 Threshold&

EOXE a e =2
HA5l2{™ 37|(Size) S
=E=oM Al 375

Ik ol ju rin

L

H ez o

[l IR
10 qu N>

=

B A M

ok
An

Digital Setup

-Do —_ — —

D508 N N TR R TR T

2817008

Digital Setup

D700 — — —

2o
1506 T T T T T T

2617-009

Digital Setup

-Do — — —

()
To) Con) @Eon e R
R s s e e o e e

2617010

MSO70000 Al2| = ZH|o|AM & H AL HEHE HAS ME o 5 AFHCH

1. E|X|& (Digital) > H{ 2 A & (Bus
Setup) == =& (Vertical) > HHA
A X (Bus Setup) = ME4 SHL| C}.

Digyital

HorizfAco

Diniital Setup. ..

Bus Setup...

®

2617081

DPO7000 Al2|=, DPO/DSA70000/B ¥ MSO70000 Al2| = & AlZF AFE A H A 41



42

ok
An

Bus Setup
Select

Config

SCLK po 14V

SDA D1 | 1av

e

Select

|_ BusSetup\ |
|

Config

SCLK Do 14V

SDA D1 [ 14V

DPO7000 Al2|=, DPO/DSA70000/B & MSO70000 Al2| = titE A|ZF Al M2

=

o

2617012

2617013

A



]
T
N

5. H{A9| 7|2 go|&
20| Z(Label) S 2
2 M elolss gt

6. EAE HA X E HASHH
tHA 2[X|(Bus Position)& &
DIHELIHE 22 Af HA
IS Y ptct,

7. HA 8 S MESHH HA F
& (Bus Type) & & (Serial) £ =
H&H (Parallel) & £ gt

Zt A S8 2 M-S O}

(43H| 0| X| o] &HE B/ A HF E=X)

= (44H 0| X| o] & #fA HE E

x)

2

[ o dES 2850

| =
A A ofI H=E MAHE = A EGHC O XE
ct
1. AE HAE MYsIHM HA 7
& (Bus Type) &l & (Serial)= M=
6"—?— EEE’I'% %%O‘” A-I &Ialé’ H-I Bus Setup
A 78S ME L Ct,

Select
Config

DPO7000 Al2|=, DPO/DSA70000/B ¥ MSO70000 Al2| = ti-& A[Zf ALE A HAM

Select
Config

_o'h
rir
d
Rl
HU

B A= MSO70000 22 ol M T ALE

SCLK Do 14V

SDA D1 [ 14V

940mdiv

2B17014

¢ |v]| SclK | Do [ 14V

SDA D1 [ 14V

— S

2617015

w2
+

o
I
L

SCLK Do 14V

SDA D1 [ 14V

2617016

43



ot
an

2_ EA'E' H{ A I;:'II;\_tlrjE_o—l ?zllEL':!% »\um'»\pri\

MEAste{™ FA|E SSo|M el

HAEZHE & (Input) S 28l 5+04

MEd o ot

_ son | D1 &
2617-017

3. & & threshold& A M 5ta{™

ThresholdE & & 28 st 7|

E Z threshold& & & g C}.

Config SCLK po [ 1w
SDA D1 [ 14V
2617018

HE A MY
HE HA O] HEE dE e = ASHCCH CIXE HA = MSO70000 Al2| =0l MEHALE S = AUS
H k.
1. H e AS dEsia Y A R

& (Bus Type) @& (Parallel) & M

E;l'll EI- I,l I:_I- Bus Setup
2. Ao &AAE FIlsla{H A E

% 7}(Add Sources) A Bl (Select)

=

44

2617019

DPO7000 Al2|=, DPO/DSA70000/B % MSO70000 Al 2| = - AlZF AFE A H A



ot
n

|

|.:

@
C
—_

~Ol M BB g otct s g
HEg 228,
4. B9I(OK) HE2 22 guct

2617020

S
2 zZ stAE g Eo| L} Ol'EH Bus Setup
AL

EHES S E
6. HA LolAM zH DS M AHSHA A
Mg Mgz A3 55001 MY
= ®M A (Remove) HES 28 -

g ct. _
o Rins v |
7. A 9 threshold & M M5t ™
Threshold A& (Setup) HES 2

gl gt ct.

DPO7000 Al2|=, DPO/DSA70000/B ¥ MSO70000 Al2| = ti-& A[Zf ALE A HAM 45



ok
An

8. M X & threshold Of C} zH 4
Threshold(channel Threshold) &

FHESEHSGL I WELIHE &

o E Z threshold& &3 gt C}.

9. 2l3}= thresholdE Ao H &
2I(OK) HE S 28l &t

10. % & A ™ (Channel Settings) 2
2 &5t 37(Shared) E£= S
(Independent) & MEi Lt =
1°T(Shared)E deg A M
(Ch) threshold & 3tLt M X 5™
2 E i 4 threshold 7} A & &l L

=

M.2E AN COXE MLE S
2 thresholdZ2 MM stai™ MY
Threshold(Global Threshold) &
F 9 285t | EZ thresh—
oldE gyt O3 ks H

2 my

"Threshold Setup

300my K00mV S00mV S00mV

Z(Apply) 2 2= 2t
A A
HA FnClad S 742 5+ ASHEE CIXE HAE= MSO70000 2ol MEk AbS e = &Y
ct

1. C|X| & (Digital) > H{ & A& (Bus
Setup) = M & & C}.

2. 74 (Config) & ME4 St C}.

3. TME HAS M5t
# 27} LEERE T kx| 2
chs A s Mefghc.

46 DPO7000 Al2|=, DPO/DSA70000/B

Digital | HoriziAco

Diniital Setup...

o

2617081

Bus Setup...

2617024

MSO70000 Al2| = 2 A|EF ALE A od A



ok
An

5. 7|2 Ho|£2 AFE3St=

oﬁ
o 0
CN

S AZ(Use Symbol)= M EH &Y E
ct. Hol& =2l (Lookup Table) conta
= 225t 7| E=2 of 2 g o]
2 oo M A= E 3 s5HA
L} ZtolE 7| (Browse) S 225t

o
7|2 HolE o FH&5Hch

2617025

6. €2 E Ao AR FTEO
M oA Addressing ?
=
=

Bus Setup

oo

BA7-026

iCapture & +%3PO1 CIXYE A Mo ofd20 EHE 2 & ASHCH oo ofd2T EH S
HoM FIHEH 75 A8 5 %lﬁ H k. iCapture= MSO70000 Al2| = Ed|of| M AL = U
&Lt
1. =& (Vertical) > =2 MH (Verti- _ B s
cal Setup) A EH EH.| C}. “ertical | Digital | Horizféco
Vertical Setup... o—‘
Bus Setup...
Zoom Controls...
Dizplay OnfOft...
2. ElxlEéI ] 4(D|gita| Input) iCap— Vertical Setup ]
ture H=S =&t vy

O | e | mET

_Nolle

2617084

DPO7000 Al2| =, DPO/DSA70000/B ¥ MSO70000 Al2| = tiE A|ZH ALE A H A 47



ok
An

48

. Threshold 82 =7 A

C|X|& &~ A (Digital So
25t oftz= 0 @l
WLCXE 2 S AMEH

OII

by

o |
o 2
H

est7| fsl ot 2
s e XY 8Aloz Wl
i AtESt= A 'E thresholdE A
Hste{H CXI” S5 J§>E(D|g|tal
Properties) HHES 2 &

m

0!
ol
21

e WX Meista® MY

’éi (Channel Settings)% ke
ZolM S (Shared) = =

(Independent) S Mef g,

M M & threshold ot C} = 4

IV |kl X 0% ro

-Threshold(ChanneI Threshold)

2 2ct TS EEwg

L2 Z threshold& A& &L Cf.

oz @ 3 threshold & A X o™
gol(oK) HES 2¢ E“—I Ct

[ aE® 1.25vIdiv

Vertical Setup

Analog Input

3206

o
125V (b)

I'w,!,/‘yw,a,,m,"pw-Amwww'«»V‘PV«‘;MW/.,\"-AWW‘.,WW,‘

|1

e

MJUM j mw.

Scale

1257

(@D /14

Vertical Setup
Analog Input

Digital Threshold Setup

Ch1
Threshold

300mV

M1
Threshold
0.0v

M
Threshold
0.0V

DPO7000 Al2|=, DPO/DSA70000/B

Il

Il

MSO70000 Al2| = HFE Al

PN
s

817029

AtE

iz
OEI

2617083



FastFrame 2 E A&

FastFrame2 Al-SstH

E=
LS — S =
NEMez 20 ST = ASHCH AlZh 2002 §EY = o Mo Ez|A AlZ
glel Eg|7 7te| &t AlZbS FAI = ot
1. At A H(AUTOSET)2 8
B, 48 9 EalHHESS A
s, 2 HEBS 50
MAXA S| C Autoset Setup
= S8EH SO & @GI=I
@ Push g} Horizontal
Position
w3
e |

2. =4 /& & (Horiz/Acq) > Fast-
Frame M A . .(FastFrame
Setup...)2 ME{ g},

DPO7000 Al2|=, DPO/DSA70000/B % MSO70000 Al 2| = & AlZF AHE

1733-020

Horizortall2couisition Setup...

Zoom Caontralz...

Autoset

Fast Acouisitions
Rundstop...

Delay Mode On

¥ | Rol Mode Auto

Sampling Modes 4
Horizontal Modes 4
Posttion/zcale. .

Resolution... @
Acouiztion Moce 4

Fazt Frame Setup...
Zoom Setup...

Zoom Graticule Size 4
1733-232

M
=

%]

A

ot
n

[H

49



ok
An

50

o
[xied

HH

—

. FastFrame OnS +5 4 C}.

z g e 37| (Frame Size) &
O/l E =g Q] 4= (# of Events
Frames)E MEi &L Ct HE

ke
12 mjo

Im == ot >
0.

I o
i

n
n

[E 1m0

Mmrr
=
T
0
R

4k
i} I'Ir
00 2 T |H0e

0
ol MlH

_,_
N

N
bl
o2

O i
-0
2
rr

|

o
o
HL

Frame Viewing) &
fol 2 =g M

Mo g
>
o
ol —~

o

12 m |y
L
inl

el dol M=z AXAH ZA

Fomo o

o
oy
ok ot
T

o

>0
0 b

My I pgo ot o
(o]
1542 4

—
=]
1)
@
<[]
3
=5

|kl

e}
=

5 FiA

ull

o 2

Cee
F>m

4
il

—_—

07 M
=
-
>
I mjo
Iy o lopy

> 0%
22 ek > i

e

-3
ne
2
znN

1o £ |5 %8 1o >
Trre
o

= El
=

FastFrame

Setup

Analyze

1733-233

Setup

Analyze

\ J 1733-238

anaze Ch1 -Che_[¥ |

v -one [ I

L

1733-235

FastFrame ZEMAM = CIXE AL HAE AIEE = gl& L Ch

lul

ol% £ mE
2 A A

o 1z
Iz K

[=]
[

2
S

fo >

t

|2t5{ ZALE 9i8h 2t Eal7{e} pat e

Ho|e & E&5le{= 4 <ol = FastFrame

DPO7000 Al2|=, DPO/DSA70000/B % MSO70000 Al 2| = & AlZF AFE A H A



ot
n

B CIE5OMIEE Z&SIHE=E S, ZHo|H E Zhof| =&t o Jt gl Ol = AlZH0| FH Fast-
FrameS AFE3HMAIL

B CE T2 el SA E= Sl A T EofA JIEE 2 = JSYCH REEsAHE
HES A2 S At oetMoz MEISEZgele 2257|707 2 4t

FastFrame =2l HAT| AlE

Zoj HMI|E ALSSHH ChE =2

1. FastFrame Z &gl AAE M

B sh o}
2. 2 =& £=(From Frame #) R
2t ofx|ef =3 e £=(To Frame ch1-Cha |v
#)E Q2450 A HE MY
g ct.

CICTN [
0.000 016 002 768 sec

1733-255

3. 52 HXstHH A /HXK
(Run/Stop) & + &4 Ct. ‘
Autoset l FastAcq Intensiy
& O @ @=L G
@ Push-Ene Horizontal Trigger )
1733-021
4, 17:_1|A—|H% AI&EF ;||:|:| Al *(Start) = FastFrame
=Euch

COCING .

Ch1-Ch4
Chi-Cha | v 5

1733256

DPO7000 Al2| =, DPO/DSA70000/B ¥ MSO70000 Al2| = tiE A|ZH ALE A H A 51



52

Blel ZAY|E che e le
Al of

57 9lE ofsto| EAIE Zefgl

| 9= 22 ol 2(No) & £ &

Uch Zelg A7\ cie =

ol 2l 2 2 A4 g ch

5 Aol EAIE Zef gl

22 2tz o8 HX|(Stop) 2
Cguct

TFastFrame

CIETEL (e

IR
[ oow s 99 e sec |

®

Default
Autoset

Setup l Fastcq
O NN ED

Intensity

@ Push-Fnel ( Horizontal [

Trigger

1733258

1733257

10

DPO7000 Al2|=, DPO/DSA70000/B % MSO70000 Al2|= & AlZF At M

o

A



ot
n

TekLink & MultiScope EE|H AIE

TekLinkE AtE5HH tted E2|7 o ELL AAE A DS 571 o] & FALE zH 2ol A
2l A 22 57 of &k AL 57 of &kl 213 2 ALEsH 27|72 AND A0l EE 2=

ﬂJ_L

(== =
=2HE =
UG IEP

FMLE. MultiScope EE|HE AL =B E2|HE AFEE = gl&g Ut

1. TekLink 70| £ 2 AtS35t0{ F= Of
o HH| & A& gLt

%

Og:

Lt

bbb
R

2597-018

2. TekLink ¢4 2lefl = =4 E=gt e ——

o EA|E L} 2.0ns/div 50.0GS5/s 20.0ps/pt
Rur Sample
449 acqs

Aute September 11, 2008 14:14:04

1733- 240

3. E&|AH(Trig) > A O|[HIE(F) Eg| - .

. . Trig Display Curzar Meazure |
A dH...(A Event (Main) Trigger | Display | C | Measure |
Setup...)2 ME L C}, & Evenit (hain) Trigger Setup. .

A - B Trigger Sequence...

B Evert (Delayed) Trioger Setup. ..

1733-068

DPO7000 Al2|=, DPO/DSA70000/B & MSO70000 Al2| = tiE Al 2 ALE A H A 53



ok
An

54

. MultiScope

E 2| A (MultiScope
Trigger) ¥ & MEd gLt

. TekLink 2 MultiScope E 2| H &

&l M 3} (Enable MultiScope Trig—
gering (with TekLink)) & 1 4 5}
0{ MultiScope EEZ|HE 2 &AM
st ct.

ZH| & &M stotof Fu|-Fd| A
HolM & ZH|E E2|HstH ™
Eg|7 ELf7[(Sends Trigger) &
MEN ST Ch2 2| = E2|A
£ Aot 8 Ats Y &Yt
SEE AZSHX| 2= Eg
HE M3ste HHldM ZE E
2H RES AMSE = ASH Tt
. MultiScope E2|HE WA 52| ™
HdH(Align) HES &4 Ct.

TekLink & ALE 350 5 o o] A2
. TekLink 512 2! #Ho|=E A5}
o &= ojf olate] AH|E HAZA Y
ct.

MultiS:ope Trigger Setup

WSS o Enable MultiSco
Trigyer

A Event This instrument:

A->B Seq o firiz)

Status Model Status

Q208 DPO71254
B Event

Enabled 207 DPO712548 Enabled

MultiScope Trigger Setup

MuttiScape
Trigger

A Event

A>BSeq D Model

Status I Model Status

1733241

0206 DPO71254
B Event

Enabled 1 0207 DPO712548 |  Enabled

1733242

[—

)

B

2597-019

DPO7000 Al2|=, DPO/DSA70000/B % MSO70000 Al2| = HitE A|ZF AL MY M



ot
n

2. TeklLink @& Mef= 4 EH=gt ) ) i
o EAIE L} 2.0nsfdiv 50.0GS/s 20.0ps/pt
= .

Sample

449 acqs RL:1.0k
Aute September 11, 2008

1733-254

3. EB|AH(Trig) > A O|HIE(F) EZ2|
A 43...(A Event (Main) Trigger
Setup...)& Mg}, & Event (hiain) Trigmer Setup...

A - B Trigger Sequence...

B Evert (Delayed) Trioger Setup. ..

1733-068

4. MultiScope E 2| H (MultiScope
Trigger) © & M8 gt ’
5. TekLink 2 MultiScope E 2|7 g  [HEM it toersun
&M 5l (Enable MultiScope Trig— i
gering (with TekLink)) & M & 5t _ Mot | stat
o MultiScope E2|HE = &4 N e o Tkt
2 Sk C — o o Tringer all instruments
srere. e
6. TH|E &4 3l5t0{ Teklink & :
oM E2|HE _g_l_;L_gl, 24 Zgk 1733-243
(Contribute) & 184 gt ct. Ch2
el E2|AE A ESE Xt
= AH™EYC}
7. AND% An_Eﬁ 3[‘7'1 L‘l’ TekLlnk A-IJ((;I MultiScope Trigger Setup
0-" M BE Z |% Ez| 7—| 3[.7' ! ope Enable MuttiScope Triggeri
— = =y = This instrument:
of zetE 2 E2|HE Z st : o | ot | Sowe | conse
E_% OR% AI_‘I F—_|H '3=||' Ll l:l- 1| Ga6 | DPO7IZ54 | Ensbled [F]
_ _ B Eve Other instruments on TekLi Unaligned
6" eE Al'%al'E AND E EI 7 -I Eo'l o D Model | Status | Contribute - |l e it
% O‘”Xl Elcl EH El 7_' T ;10.” A.I § 0207 | DPOTIZ54E | NotEnabled =]
e :
5|28 AlRSH= OR Ea/HE e s
2E 227 ReolM A5 g

o

DPO7000 Al2|=, DPO/DSA70000/B ¥ MSO70000 Al2| = & AlZF AFE A H A 55



ok
An

8.

10.

56

MultiScope E2|HE M &Ho
HE(Align) HES F&4C

ZHH| 7} TekLink HHE Q3 & A
5F0f TekLink HHE 2 3o A& =
ZHH|E &ol5tH stediH M2 11
2l (Refresh) HHE S + &L Cl.

MultiScope E2|H & 0| &M 3} =
M Eg|A m=gtol EAIE U CH

MultiScope Trigger Setup

MultiScope
Trigyer

A Event
D Model Status
1 Q208

Contribute
DPO71264 Enabled

A>BSeq

B Event
Model Status Contribute
DPO712548 | Mot Enabled

MultiScope Trigger Setup

MultiScope
Trigger
A Event

1} Model Status

1 0206

Contribute
DPO71254 | Enabled

A->B Seq

B Event
Model Status | Contribute
DPO712548 | Mot Enabled

Q& 0.0V

MultiScope|AND)

1733248

Trigger all instruments
inthe TekLink netrark

[Trigger a
inthe Teh

DPO7000 Al2|=, DPO/DSA70000/B % MSO70000 Al 2| = & A[Z}

/A

AtE

1733245

Unaligned

x
0I:I

1733246



Pinpoint E2|A

Pinpoint E2| A

Pinpoint EEZ|H A2 2 A X B EEHUA ZRF AEEE =A=13 E2lA e &4 M3 =
o, SYOIME Sl L= EF A[ZH 0| = BO[HMETL W SHX| b= 29 E2[H =AM E MAHEFEE
T 9JEL|EF Pinpoint E2|H = 7t& S&et ER[H O|HIE L= E2[AH O|ME =ME 7|E2 2 5}
= Ol E Z &g X[ Y gt
ol doll& E2|H A AE AtES fIst i & HXIF Z2etEof ASH T
= L:

=2i748 iy
Eg|H o|HI E
E2|HOMEE Wty | Z=2| 0AlZH ZQEE MYt 2= ot Z= OOl = s = ¢l
Eof 2 E AlZh Lol IR Ch EH[E AlSoiM ot el 2= AMY ER[A £ 22 M0 &
=t ME X EE &5 & FAIZHCH E2[H oW ET 2H¥SHH Zu| 7t ot 2 Z =9 ALE ER|
HEZE US| flol HES S AMF ERH 22 EC[H O|HE 7 = QLEF =
AlEHCH E2|ATL M EM 2 S0 RED E=E2 X AZho| Btz 2 W7k X| Zu|olM ot E E2|
HE ZotSolx| E&EH et

Eg|H RE= E2|A O|HME 2 Al F8|7t S2sts SRS 224 o

= BE E2|) BEoAE E2|HE Z oo Hu|J}l G S HSY & UG C 22|t ey
Al o oix|eto 2 256t utg o IE Uk ol A S olof RXIE U o
ol EAISA| kgt

= AE E2[H REAME E 2| A7t L3R glote ”HI7FJLP§-,% 2S5 JAEHE A 2=
= E2|A o|H EJ} L5t = A== EIO|HE At 2t CF. EHO|H AlZho| Z=1t=|7| Mol &
= ChE ER|A 0|“.1|57F€-’12”4 ZHI7L LA 2 EEI7-|5' LiCt. EE2|H O|HIEE f7|5t= A2+
Alzh71gk d ™o wat chE U of.

|'0II

NS 2EE 7R E2HY O/HE T A 7‘X1I EE|7-| By EI¢%E4|0|9| utd ot 37| 5= %]
Zeuct o2 stHes 7P§’“ B FAEUCH RES ER[AH7 EYsSIH et o2 EAIE U T

E2|H MM (Trigger Setup) M o{ el ZH E2|H (Force Trigger) HES s8] ol X|-E2|H 2 =0
M IH='|7P7”(‘||EEE|7‘|5| SE g AsHCH
.I

o

Eg|A 2EE dEUHCH XMt E2 | 22t =22

Eg|y EEQT

E2| EE2TE S5 25 AR F o|Fo| E2|H el4o| MetE s 7|22 A& 22l S
OLEAIZ 4 UL LICh 0|2{8h AT2 A~ 0| £ Z0|5E Ol E BAES G2 O[HES 2L
S ga 2 uAES K Wi oM EoM E2|AY + UTE SLIch FulJt R ets =2l
O ENM ERIHE AP EE2 TS =H st oHE Aol EalyEe 2e 4+ Ak

=274 (Trig) > EE 2 I (Holdoff) M 70l M E2|H EE2 T8 M etich AASH 8 Tl 2
2lol £ RS FEIAAIR

DPO7000 Al2|=, DPO/DSA70000/B % MSO70000 Al 2| = & AlZF AFE A H A 57



Pinpoint E 2| 7

salH HEY

E|AH HEZ 2 M5 oH BES EC|A 322 Metstx| ZHE et o x| E2|AHZ M= A
= ZEAHEY RYS AIEE F UASHLCEH 47|ol= AC, DC, M Futs MAH, DnF ot M Ao 2
Lo|=HMH So| YAEHCH 2 2 & E2[H Y2 DCHEH 2 AISEHCt

E2|H(Trig) > AO|HIE(F) EE|7H M (A Event (Main) Trigger Setup) Ml mollM E2|H HEE S
MEISHCEH XM S 82 | 220 T LS HEISIMAIL.

+8 9

T8 x= oy HIZEdAM EAHI LM st= X E Mol gtucCt =4 (X[ E AlEstH E2|A
O|H E o|M % o| Fof Fu|7| 2 55t= &2 MEIE = JAGHCEH E2|H oMo YYo=z £
22 AN Eg|AH B 20| E2|H o]l Fof| MSt= 2T E 2 20| AlF E2|H B2 YL

MM E2|H OOz EME NZE M REoHH AFEe = ASLICH o E E HAE 3|20 M &
X e 22l delS Feds A Zel XM E2[Hstn 22X Mol Ho[EH & Z&E = U
S UE AN ER|A FYIE 37 & = AsHCh 22X Mol of™ abgto| M St=X 2AMs5tH 2
2lx|le| delg FHot= ol =30 H=HEEYE T UASHCEL E2|H O[HEZ 2l A/ AR O[A
dojLis M S oot AlE EB|AH FV|E E2|AH o| =2 Ho|HE Z=ater 4= A S 2hE 2
MYSIHAI2,

= = A‘I EE—lj‘I EO._|E
Ct. 2l ZEE26HZ ol X[olAM E2|H ZAETL Hst= 1% & 28 & ot
XAE E|H AIAH
A(F) E2|7 Al AE SHLIBIO 2 E2|A S £ YT, A(F) E2/7{9t B(X9l) E2| & Z s =4
HOHMEo o ElAHY == ASHLCH AN ER2/HY S AMESL AP AERHOHMEE ER
HAAH S ZFH|st2 B E2|7H O|HIE= B EC|H &ei7t ZF=H 2| & E|AZHCH AR BE
ElAH= gt o2 HEol AAE 2 G B E2|A Aef= Al ZEX[d0|Lt XY E O|H E 5=
E7|ete 2 & = ASH T (63H 0l X2 A(F) E2/7 & B(X/21) E2|AH ALE E=X)
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Pinpoint E2|A

2. £2, 7|27 A BES MHBY -
EI‘.. 9" % %! X% %7;%3" E:| D._:‘ E E| 7‘| ig | Display | Cursors | Measure | M
(TrE])E> O“o = =< (Edge SetuD) Source ~ AEvent (Main) Trigger Setup...
H+& AtS g4t _

(Readr) A- BTrigger Sequence...

BEvent (Delayed) Trigger Setup...

Quick SelectATrigger 4

Level
ot Pt Quick Select BTri 3
Set 50% UIC_ elec] rigger

L —T,—E(ADVANCED)% —II_—El’l EI‘. Slope Node Edge Setup... b
[ Glitch Setup...
B EZ|H(Trig) Ml 7ollM 2 F E
2|H fes e gt O O Ddh Setup..

Runt Setup...
Window Setup ..
Timeout Setup...
Transition Setup...
Setup/Hold Setup...

Logic Pattern.. @
Logic State...

Comm Setup...

Serial Pattern Setup...
Bus Setup...

Video Setup...

SPI Setup...

12C Setup...

RS232 Setup...

CAN Setup... J
Holdoff...

Mode...

Run/Stop...
2617032 -
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Pinpoint E 2|7

4. s E2|H F&Hol of A : )
= EEEQ A _,C_?_;I_O:‘ |7_| A Trigger - Glitch +:3litch — Acguire
— T = o = 4
Jg% %LESj—Ll |_—_|.. = E_I 7.| /\E-I?gl% TnggurTypE Source " Glitch Width Tf‘i;Ellﬂ:'-‘" B>
st ZEEZ2 EE|A Zhy| T | ] L D—A“ e e
oo 9 Mo whaf chE U cf @ == Kin
e s @&
Shared v @
‘ 1733-066
Pinpoint E2|7{ A1EH

Eg|H 7d Eg|7{ Aef

ofl x| i 77| EEE R Mol A5 ol K| = 5t o Xlofl M E2|HE Y
Cl. HEE ME AIEF 2 2= DC, AC, LF A, HF M7 2 Lo|= X|
HIt A&YCLt.

=2 X Mo ANYE ZHC AL 2 EA0A E|AHSHAHL X HE ZEECE &
HebE2 :LEI x| & FA g4 ot

= n ANHE AZEH W E= 8ol = EA0lA EB|H gt EZX|E|
st A EIE HAOM E2|HE = ASH

HE |‘| stute| A H = wXbsHX|[2F X B A E CHA| WXtstZ| Mo & =
W AHE WASHK| Zot= HA i%oﬂﬁ Eg|AHELL L ZXEE
E=EUHAHEE HEE HAESIAHL XY E ZEECHE2 HEUS HAE
= AsYCt Olﬂi?iﬁa*ﬁ%EFEIH of =e| MEfZ AHE £
T A&},

& m 2 MooF ekl g et =7 AFSSHHLE Shet 2 A BH e
Ct A s145HHE E|AHELUCH MSIYUA B2 E0{ AL L}
7t &l & Eg| A gt §e™ E2|H(Trigger When Wider) &
HME AISsIo] AMZES 7| 222 E|H O|HEE HHSHAHL, =2
Mo|™ Eg|7H(Trigger When Logic) &8 S AF25H] ClE2 a4 e =
2l MEl E 7| ZEo 2 A™ T ).

Elel ot J—I— ANYE A 2ol HEAJLHAEEX o™ Eg|AHE )

0| 4 XNHE AZHEC 2AL 2 S22 F A Alo|E & ctst= &

T Ele2g

off X|ofl M E2|HE Lt

s
+ slauch,

HAoX= ZX|E[E E= HA

60 DPO7000 Al2|=, DPO/DSA70000/B % MSO70000 Al2|= & AlZF AtE M H
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|m
o
Al
40
oo

Pinpoint E2|A

E2|AH el

A

n
g E
o

Z|Cf 1.25Gb/s2| H|O|Ef &£ =& 64H| E X &H mfEHof| A| E2|H = o
(4GHz ol ot e =i 3.125Gb/s(4GHz O] AF B & of oF 5 Ehgth) &
= 5Gb/s(4GHz O &t B & )o| H|O|Ef £ = 2 40H| E A& f &= of
M Eg|AHEUCH R HEARZRAE EIUCH 88 PTM EE
PTHZI 223t cct o]l 2Eo= 28 537 =&t 28 5
TE CtA =7|5b512{™ 50% A& F5(Push Set 50%) = 2EE& +&
=

= =]

ot 1 2) T Ato| 20| Bh= sl
fiCh T B E 2 AE 5 X
Holef WEle] S URloIA MBS A2 5 8

2
02
rr
ﬁ
2
AN

i

uf &

Ll

>
o

jm &
w0

+

0z
By

HU (i
N

oot

i
0 79| g L
ol

A N
o
il
o

=
==

X
e

g
Mok
[

o ([
el
m

(m
Mo
N

il

ofm
e

R EEE

=
EE2 2 2S35t0{ E2[A o|HI Eo o7 H4E
= MTHOIAM AL Jts 2. ol 2E0= 2
.28 STE ot Z7| &5t H 50% 4 F F

(W Ll N

i 12
o >
A A T I
2 4o
o

Il
I

U]
e
ol
o
R

0% | O I 0 HU ofm | OM Hu | FE > | Jju O ju | o> > ok |

H

o1 Qo Ijo
n

= L=

10
o G
x
|
1o
oy

E(of: XIgE F=2)E E2| A= O

T

Rl

U ol
% fol

>

ST o
e
Nir

N e

rrd

w

T

E
w |2 o
Im
n

4> 1
2o IM
>
T
ful

|12C L“Wlfﬁ

Inter-IC Z2EE(I12C) Al S (A=, HX|, BH=E= = A&}, QA £k F
2, dole, 4 2 Oole)E E2|AHEUCH 12C E2AH ZE=
BUS E2|7H F& & AI235t= MSO70000 A2 =0 M At2E =

RS-232 1
\nannanan
1733-192

RS-232 A5 & E2|H &L cHDPO7000 Al2| =2).

CAN T

SOF edge
1733215

CAN A &5 & E2[AH e CHDPO7000 Al2| =),

DPO7000 Al2|=, DPO/DSA70000/B

2l MSO70000 A|2| = W2 A|ZF AF2 A0 A
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Pinpoint E 2| 7

= s|lo
Eg|AH 2tef g2l
M oidol el 2l0|E &= HE4E Soll E2|H MEf E =eled = AsH ot
Eg|H ME|E Solste{m =d| [ Trigger 1
(ARM), =d| 2t (READY) % E g Advanced
7" (TR'G, ) x|_ Dn_:i EHLE_' EE%% Eﬂ" Source
o| SFAI Al @ €h2
._°|'::| |_._ th3 ) (Tha
Line Trig'd
B EZAHII AN JA2H™ FHH|JI 7
st E2|HE Ay oo o
of AlF ER|A RES MDA LY
= At
Slope Mode
05 (Chorm )
m Fo| 2EIF AN AoH Hy|vt =D o
TR ELH S s F O O
fon YN g IIctell e A 1733024
ot AFH E2|H HlolE{ 7} &
=SR-3}
= Zo|7bAN UOH E2i7 5=
Jhofe 2 m=of AVH E2i7) 2
S2Aen e #edo
m EE2[AH Y FH ABRTIEF AN
o™ F&E5HAOHIE E2|77}
lAlE[ion] FH|Jt XA E E2|
HE 7|cte| A= WLt X
HAE E2| AT AA =T XA
otgol Atz E2|H 20| A
Euct,
B Fd|, EZ[AH Y FH| 227t 2
FHM AcH &S50 DX E A
4t
U 72 22l of ) S AL
SP7 ZEate e ClA B2 of sfeie]
S2H BEZE selstiAIR. B
7l al 13 = —_— .
TR Of x| % g EB|HolM Cf |[@ & /ooy || 100ns/div 25.0Gs/s 40.0ps/pt
=3 Zo| 2tz chE 4 ot ; | Rur Sample |
2 801 acqgs RL:25.0k
1. E2|H &2 =Chi 0 o 0 D15-D0 Time Res: 40.0ps/pt
o ~ Aute June 12, 2009 11:22:14
2. £2|74 7127] = &% O X Sl g
3. Eg|AH <
4 NZHE

62
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Pinpoint E2|A

~ a
A(F) EE2|AH % B(X|Hd) EE|AH AIS
Zhebst Al 5ol taf ME AOIHIE(F) ERIHE ALSE £ 220, F E2|79} B o|#I E(X|ol) E2]
HE & AFE25H0] HECt SESHAMSE ZEE = lELch AO/HIED whMslH nied g Eg|H 2
EAISH| Mol EE|H A|AHIO| B O|HIEE HA S C}.
A EB|AH

1. E2|H(Trig) > A O|HIE(F) Eg|
A MA...(A Event (Main) Trigger
Setup...)S ME{ g},

I

Dizplay Cursor | Measure

A Event (hWain) Trigger Setup. ..

A - B Trigger Sequence...

B Evert (Delayed) Tringer Setup. .

1733068
2. AO|HIE(A Event) HolM A EZ|
ZE eSSy e
Trigger - Edge
Trigger Type Source
eage ] fonr v
Setto 50%
Settings
1733:069
B E2|H(X|H)
FHLE - B _E 2l A= MU|tiSCOD_e Trigger - A->B Sequence AEdge — T
Eg|AHI} &M stE d2ol= A8 B
T & ot Postion
N
3. A >B &=A (A —B Seq) H ol M —U— A Tragar
S42 degc)
N B Trigger
4. E2|7 x| Alzbo|Lt B Ol #I E Ui e
_Ql _/F% /él 7g| ‘3:!- I,I E_l- . Trigger Delay

DPO7000 Al2|=, DPO/DSA70000/B % MSO70000 A|2| = tiE A|Zf ALE

1733-070

AN 63



64

Pinpoint E2|A

5. B o] #l E (X1 )(B Event (De—
layed)) B0l A B E2|H &M
Aot

2
= AEvent

=
2

7
o=
—_=

FO Im Ho

(Mode) B0l M E2E(Normal)
{ 22 % XS (Auto) ==
MES S O}

—

L
Trigger - Edge

Trigger Type

7
1733-071

A-=B Seq

A E2|HE H[E FH[L . AL
T E2|AH =52 nHM B O|H Eof
M Al ZEE L B

AEZ|H &

B E2[H A

X1 AlZho|%2| B Ea|A

ZHd| & Z=d| gty ch. A}
Eg|AH XA Azt
X eHm| B ol X|of| A A E}

1]

A E2|AH

B E2[H &2

DPO7000 Al2|=

A ER|AH BRE

DA

, DPO/DSA70000/B ¥ MSO70000 A|2|= HitE A|ZF ALS

1733-072

B AbE BRI A RE

AERIH ZAE

E IOl E
sl OHIE 7| (n=g) B T o1 EUE

A EZ|A |

]
|'O
Im

Vi

Mo
= o

A



E2|7{7I B E2|7 o|HI E Moj
St E|H A AEHIES YA X 0|'E
Ej 2 X| & 4 S ch AR

Al
(=]
A

A

o
= T AMHeE = o 0
HIEJF WM 5ol E2|] A|ARIS B Amme Ea|Hste
O|HIEE J|Ccl2|X| &2 A O|HIE

S chAl 712 A g

Ls —

Pinpoint E2|A

Mas o

A ¢ B O[HIE

#e g
B BEZ|AHXAA D =H XA A ZI2 S8 XM J|succh A EE|A
12508 e, T8 XS AL sl A

=2l 91| Bae dole A=t S22 Y=ol 2ol § WA st0 EAIE B0l E2E of Ha
SHoll e Rl Btk sk EalH 9x| BH Al ol = Ao Ea|AE o Hasl WA+ A=
YIS A8 Y + UGUCH CIASeolol o X| E2|HE of BEsti| shxlsta{ o ohg HALE &
A5t Al 2

e——— Z 2> 100t E ———

1. C|AaZeolof E2|HE H HE
SIAA| Bj x| 3le] o SFAFE Ea|A
& (Enhanced Triggering) 2 4 &4 A Event
Shuch, ESHLO|= ASo E
2l HE o H=stA o x| st ™
Lo|= Al 5o 2™ 3H(Optimized B Event
for Noisy Signals) & ME4 &L C}.

Lol= M&of % &zEHOptimized
for Noisy Signals) A& st=2 &t
A=l E 2| A & (Enhanced Trig-
gering) & MEi s A R0l 2t ALS
g = A& Y.

rigger- Mode

A->B Seq

DPO7000 Al2| =, DPO/DSA70000/B % MSO70000 A|2| = 12 A} A2

A A

1733-259
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Pinpoint E 2|

HE HA E2|AY

66

HEH HAE ER[7sto] 2HME &g Ch CIXE A= MSO70000 22 of A 2F ALS
=

1.

HE HAE dgetch (415
O| X| 2| &/

Eg|AH(Trig) > A O|HI E(F) E&|
H MH ... (A Event (Main) Trigger
Setup...)S MEi gt C}.

. A O[HIE(A Event) B & ME 3L

=

Trig

Cisplary Cursar MeazLre |

A Bvent (Wain) Trigger Setup. .

A - B Trinoer Sequence. ..

B Evert (Delayed) Trigger Setup. .

1733-068

Trigger - Edge
Trigger Type Source
Edge v Ch1 A
é Setto 50%

Settings

shares [}

1733-069

R
A

DPO7000 Al2|=, DPO/DSA70000/B % MSO70000 Al 2| = & A[Z}

L
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O
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4. HA(Bus) E2|H e S M8

Pinpoint E2|A

Edge
H ot Gltch
Width
Runit
Tirneout
Patiemn
State
SetupHold
Transition
Comm
[T cop Window
Yriamar
' L e Source
; r
_ Edge Dz
| H 5 f : .
L Set to 50%
EgAHEY HHAE MEASH|C z
5. EBIAY B{AES Meighct Tioos e
Trigger Type Bus
Bus ¥ All ¥
B1
— |
" U
Pattern
; Occurs v
Settings
Shared ¥
Time

DPO7000 Al2|=, DPO/DSA70000/B % MSO70000 Al 2| = & AlZF AHE

500ps

A0 A

= o

2B17-064

67



Pinpoint E 2| 7

68

Mol M oE S ME S

>
M

Med g ch,

I EE AL Sol ER|AT o H
s My

Trigger - Bus

Trigger Type
Bus v [e A

. Oceurs v
Settings
Shared v e
500ps.

N

l ABus — Acquie |
=7 L

This is a 3 bit Bus.

Binary

B17-065

Pattern Editor

@
l

Bus
B1
Format
Binary v

This is a 3 bit Bus.

«©® 1.88V/div
D 5.75Vidiv

2617037

DPO7000 Al2|=, DPO/DSA70000/B % MSO70000 Al 2| = - AlZF AFE A H A



2. E2|H(Trig) > A O|HIE(F) EB|

Pinpoint E2|A

3 A S E2[AHSI0 2HE R&U T CIXE A= MSO70000 2ol M 2H AL S 5= U5 Y

Il

Mg ufAs MEELC (415
ESENTETEAES

- . Trig Dizplay Cursar MeasLre |
H MA .. (A Event (Main) Trigger = = =
Setup...)S MEi gLt & Event (hisin) Trigger Setup...

A - B Trinoer Sequence...

B Evert (Delayed) Trioger Setup. .

1733-068

3. AO|HIE(A Event) B2 ~MEHSIL

=

Trigger - Edge

Trigger Type Source

Edge v|  chi v
é Setto 50%

Settings

shares [}

1733-069

DPO7000 Al2|=, DPO/DSA70000/B ¥ MSO70000 Al2| = & AlZF AFE A H A 69



Pinpoint E 2|

4. HA(Bus) E2lH &

L cf.

6. SPI HHAE ALESHK]
ChA 2 A&t

7. EElAE HA NS E

=

70

02
1o
e
I
o

500mV,

' Serial

MultiScope
Trigger

e (Edge v

A->B Seq

B Event

Trigger - Bus

Muttiscope
Trigger

A Event
A->B Seq

B Event

AEvent

B Event

AEvent

o [v e 7]

B Event

2617038

2617069

2617040

2617070

DPO7000 Al2|=, DPO/DSA70000/B % MSO70000 Al 2| = - AlZF AFE A H A



Pinpoint E2|A

ol
>
0
o
N
i

9. SPIHAE ALE
Ct2 A E AL

10.E2|7{ On(Trigger On) =
S50 M E2|AHE B A
MEd S O

11, MENSE EE|7H On(Trigger On) &
=of utz} ct2 s ME st
12. 34 84| (Address Format) S5
oM =& A S MEEHC]
13.7| o =t HE (Edit) MO &2 At
5t Eg|AHE T gt MY

g ct.

14.4| 0| & & 4| (Data Format) =5
off M Clo|Ef ¥ Al S MEdFHL L},

—

15.7|tf =} HE (Edit) MO &S At
235loi EE|AHE HlolE S A

ol A o o] & ekt of =2

c2 deehch

16.5
A

to

AEvent

B Event

AEvent

B Event

AEvent

B Event

Stored 7]

Shoeg v

12C

Repeated Start
Missing ack

2617064

s+ a1

2617065

oe " )

2617066
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Edit MyScope Control Window @
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Edit MyScope Control Window

Lok in: | ' MyScope
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tom's controls, kow
trigoer.kow

14 tov
050914 _173203.kew
Cursorsz.bow
Cursors.tow
save.tow
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™ =Z & (Screen Capture...) S Sove s

Al_-l E_|H El' Ll E.l' . Save As... F12 Screen Capture
Save Options 3 Waveform
Save All Waveforms... Digitals
Recall. Setup
Recall Default Setup Measurement
Delete L3 User Mask
Page Setup... Histogram Data
Print Preview Timestamp Table
Print... Ctri+P
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AMH5te{H M. (Options...)2 == .
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= 3EA 2 AHE ot B o T
Waveform " Color (Ink Saver Mode)
1" Black & White
& Full Screen
".U- ™ Hide MenuToolbar
Setup " Graticule(s) Only
™ Readouts Below Graticule Save
L ok | [ conca | Hep | | cance |
m I~ Set Front Panel Print Button to Save Help
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™ Prompt for file name before saving
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1. A (File) > £&...(Recall...) =
b

Reference YWaveform Contrals.

Save Wavetorm Ctrl+5
Save A F1z ¥
Save Options 4

Save Al Waveforms...

Recall... @

Recall Default Setup 1733-159
2. =¥ (Waveform)& 3= et ch.
Recallvwhat e _ .
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File name: | ﬂﬁ ,jecall"
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Reference Wavefarm Controls. .
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Save Az Fiz2
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1. CIXE T s Masteid Tl
(File) > X ZH(Save) == C}E 0]

File | Ecit

Save

% o=z x'I él' (Save AS) > El X| Eé-l Save As Fi2 TEreen Capture
(D|g|ta|s) % Al_-l E_|H EI' l—l E-l" . Save Options Wawetorm
Save AlWavetorms Digtels

Recall
Recal Defautt Setup
Delete

prirt...

Minimize
Shutcown, ..

Exit
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5. M Z(Save)S 2 & & Ct. ?
Setup
Name CEGERIERE | [ [ e |

Save astype: | Digital Data [*.cav) j Cancel

Measurement [~ Auto-increment file name

I~ Prompt for file name before saving

[" Set Front Panel Print Button to Save
More P Help
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1. e (File) > X & (Save) £ = Ct
% ol = 22 x‘l él- (Save AS) > IAé Reference Waveform Controls..
7c(->l (Setup)% An_-“%{ El'l’l E-}'. Save Chil+s

Save As... F12

File | Edit | Vertical | HoriziAcq | Trig | Display | Cursors | )

=|| Screen Capture

Save Options » Waveform
Save All Waveforms... Digitals
Recall Setup
Recall Default Setup Measurement
Delete 3 User Mask
Page Setup... Histogram Data
Print Preview Timestamp Table
it cinep _
17061
2. d¥(Setup)= 2= & ch. Y
Save What: E =
_ _ _ ————— Savein Dsciloscope Memory
3. d¥s MEgHxS dsiad | M m =
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5. X &(Save)2 S & T s
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1. =2 (File) > £&...(Recall...)

M Ef gt o

o

2. 43 (Setup)E 2= &t

3. sEet MY g M Bt Ct |
H =222 1070 I x| & st ==
Windows C|2l E2|of| M M m}
dE2 s A&
A XAAZLEY MY E &
X|otei® XHAAIZLEH g2 S
Z 35X &2 (Don’t recall deskew
values)2 2 &Lt

4. $&(Recal)S 2= =24t
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B CAT0 MYE Y2 S ESH LT HY 2E2|X R0 MEstH sl A

Mgt = AgHct

Reference YWaveform Contrals.

Save Wavetorm Ctrl+5
Save A F1z ¥
Save Options 4

Save Al Waveforms...

Recall...

Recall Default Setup 1733-159

Recall

Recall'what: i i
————————— Look in: Osciloscope Memorny

X

@)1 Factory @Cle Factory
@)z Factory @07 Factory
(e @03 Factory EDs Factory @
@4 Factory ED2 Factary
@05 Factory @D 10 Factary

Look in: | = Desktop

(@) 11 Factory Defaults

~| & & Xk Er

[C)stinger_captures (B 080918_152023, 56t
() version 1.3.564
@ os0s15_152012. 58t

Eos0915_152019.5et

@

User Mask.
File name: | j E Recall
Files of type: |Selup files [* set] j Cancel

[ Don't recall deskew values. Keep existing deskew settings

.

Help
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1z}l (File) > A ZH(Save) == o}
E 0|52z XM ZH(Save As) > &
g‘jﬁt...(Measurement...)% M EH
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File

Vertical | Horiz’Acq | Trig | Display | Cursors

Edit

Reference Waveform Controls..

Save Cirl+3
Save As... F12 Screen Capture
Save Options 3 Waveform

Save All Waveforms... Digitals

Recall. Setup

Recall Default Setup Measurement
Delete L3 User Mask

Page Setup... Histogram Data
Print Preview Timestamp Table
Print...

- -
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Save Wwhat

Savein.

5 data

X

= =@ X ek Er

Wavefor
& Displayed Measurements Measurement Format
Numeric C5V =
" Measurement Snapshat
Digitals

2
= @&

I Save

e ok | Concel | Help
Cancel |
Meast
Uplions...‘ I Prompt for file name before saving
Moe P I™ Set Front Panel Print Button to Save e
el
2617054
il x|
ﬂ&weml_}daﬁ ? Jﬂ--‘xﬁ(.'
‘39‘3225 111228.csv
Screen Capture
Waveform
Mame: I Save I
Save sstype: [Measurement Numeric 5V Mes[ csv) =l T

Measurement | [ Auto-increment file name
Options... ™ Prompt for file name before saving
Moz P I™ Set Front Panel Print Button to Save

Help
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! (File) > X & (Save) === Ct

File | Edit | Vertica | HoriziAcq | Trig | Display | Cursors |

% ol =1 EE x-l él- (Save AS) > AI‘ Reference Waveform Controls..
X} otA 3 (User Mask) & A = Sove cies
st | E.}- Save . Fi12 —
Save Options 3 Waveform
Save All Waveforms... Digitals
Recall.. Setup
Recall Default Setup Measurement
Delete 3 User Mask
Page Setup Histogram Data
Frint Preview Timestamp Table
Print Cirl+P ‘
Minimize Crl+M ‘
Shutdown
Exit
2617056
2. AFEXLOfAF (User Mask) € 2 EX £
é! |3:|H’| EI‘. 55"'9""'“5‘ Savein [ Masks ? =& X ek Er
3. olA3 S Xae xS Mg T @
L ct
Waveform
4. 0f2~3 0|52 U otz ot
F82 Me gt ch, B
Digitals
5. X &(Save)2 2= &t ®
Setup

/Name = ﬁ Save I
! Save as type: IUser Mask files [*msk] J Cancel

User Mask [ Auto-increment file name
I Prompt for file name befare saving

M » I” SetFront Panel Print Button to Save
ore Help
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File | Edit |

Wertical

Reference Waveform Controls...

Save Cirl+g
Save As.. F12
Save Options 3

Save All Waveforms...

Recall.

Recall Default Setup

Delete 3
Page Setup

Print Preview

Print crse |

| HoriziAcq | Trig | Display | Cursors | N

Screen Capture
Waveform
Digitals

Setup
Measurement

User Mask

Histogram Data

Timestamp Table

Minimize Girl+M B,:16.0G

Shutdown

Exit
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X

Save Wwhat

Savein: [ 5 cata

L]k-lXﬁ‘"

NG 090225 111228, csv
Screen Capture

Wavefom

VAN |

5
b

e ]

J Cancel

-' Save as type IHlstogram files (*.cav)
Histogram [ Auto-increment file name
™ Prompt far file name before saving
Moz P I” Set Front Panel Print Button to Save

Help
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a2 (File) > A ZHSave) == CIE2
0|52 =2 X ZHSave As) > AlZtL

Vertical |

File | Edit HoriziAcq | Trig | Display | Cursors | N

Reference Waveform Controls...

2l E (Timestamp Table) & 1 &4 sove s

|8:| | E'}' Save As.. F12 . _Screen Capture ‘
Save Options 3 Waveform
Save All Waveforms... Digitals
Recall. Setup
Recall Default Setup Measurement
Delete 3 User Mask
Page Setup Histogram Data
Print Preview Timestamp Table

Print Cirl+P

Minimize Cirl+M
Shutdown

Exit
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2. A Z2tA9Ql(Timestamp) S 28 & =

e
Save What:

|,| L__[, @ Savein: | 3 data j "lxl‘j"
Screen Capt
3. &A & FastFrame H| 0| Ef e
o2 x™Matade M ...(0Op- =
tions...)& 2 et ct. THX| iaidom ——
[cni-cre =]
A2 o= 4CHHZEZ AHE
|’| ':[, . Fast Frame Data Hange
. Digtals CoFames [T w [T
2 ’7(" All Frames
= @ ok | [ cacel | o |
N = Save |
= ' =
= Hveastype: | TimeStamp files [txt) hd
Timestam /&utolncrem!en:n;eenaarr‘;ilgs : J ﬂl
Options. ™ Prompt for file name before saving
I More | SetFrant Panel Pint Button to Save o
BA7-061
4, AMZE2Ql S S X E M savens x|
'3:!_ Ll L__l- Save Wwhat Savein I_)data , j - ‘ » = _
= p— Screen pture
5. AMlZtael o|E2 =t otE 1t @
o 282 Mefgtct
B Wavsform
6. X & (Save)= 2= &4 Ct

N | Go0ic 15502 |
- ame - E Save
== Save s type: [ TmeStamp fles -] =l Cancel

Timestamp [~ Autcincrement file name
Options... I Prompt for file name before saving

Maie P I™ Set Front Panel Print Button to Save o

817062

DPO7000 Al2|=, DPO/DSA70000/B % MSO70000 Al 2| = & AlZF AFE A H A 135



1. HE(Edit) > SAt M3 .. (Copy
Setup...) & Mgt T}
Undo Last Autozet
Copry Ctri+C
Clear Data

Select for Copy  *

Copry Setup.
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2. o]l o] X[ (Images), I & (Wave- 0
&3

forms) = = & A %t (Measure-
ments) Bl S 225t st & Sopy. et
AI_:I % M E;I'! Iszl}- I’l L_‘l'- Images \Waveforms] Measuremerts |

Palette Screen Capture Format
' Color Bitmap
" Color (Ink Saver Mode)

" Black & White

View
* Full Screen
I Hide MenuToolbar
" Graticule(s) Only

[~ Readouts Below Graticule

Help

Copy 0K

1733-170
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Undo Last Autoset

Copy
Clear Data
Select for Copy

Copy Setup...

| wettical

Undo Last Autoset

Copy

Clear Data

Select for Copy

Copy Setup...

File | Ecitt |

Cirl+C

HE ME

Ctrl+C

B | Full Screcn Chitmap)
Graticule (bitmap)
Wiaveform (data)
Measurement (data)

ELX-3564 System Controller Test Report

]

@
®

1733171

Wettical | Ha

Reference Wavetarm Controls...

Page Setup..

Prirt Previgw

Frirt...

Ctrl+P

Autoset Dsﬁ"mn

O O

@ Push {Fine)

@

(o o] o) 63

Horizontal [ Trigger )
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'—l = Print
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™ : Properties...
2. Ho|x| MH...(Page Setup...)S e _ Properies.._|
= S .
= é! Io=||- Ll |___|. ) Statuz;  Feady
Type: #erox Phaser 8400DF PS
Wwhere:  B8-2L14
Comment: 58-2L14 - 128.181.216.174 [~ Print to file
Frirt range
Al
. toc |0 ﬂ
- K
FPage §etup...| Frint Preview | QK | Cancel | Help
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~ Paper —
Size: =
Source: lAutnmaticaIIy Select ﬂ
Ornientation Margins [inches]

' Partrait et [000 [ mign: [000
" Landscape Top: [0000 ﬁ Battom: |0.00 ﬁ @

Palette | Wiew

& Color * Ful-Screen

™ Calar (Ink Saver Mads) [ Hide Menu/Toolbar
" Black & White | ™ Graticule(z] Only

I” Readouts Below Graticule

[~ Set Front Panel Print Button to Save

F'rintPregiew...l | QK | Cancel| Erint...l Help I
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